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Near Stream Recovery After the Flood of 1995
By David Demarest

June 27, 2005 will be the 10year anniversary of the formation of
two small storm cells, one in Madison
County and one in Albemarle County,
Virginia, which dropped up to 24
inches of rain in localized areas in less

The resulting floods were
determined (by magnitude) to be
400 to 2000 year occurrences.

than 10 hours time. These two cells
unleashed their precipitation after four
days of steady rains had already
saturated the soils. The resulting floods
were determined (by magnitude) to be
400 to 2,000 year occurrences. There
were three major watersheds severely
impacted by these two events in
Shenandoah National Park. The
Rapidan and the Staunton Rivers
(actually a tributary to the Rapidan) in
Madison County, Virginia were
inundated during the day while the
North Fork of the Moormans River in
Albemarle County, Virginia was
affected in the early evening and night.
The damage to the lower
portions, typically below 2,200 feet
elevation, of these three watersheds was
astounding. Prior to the floods, the
Staunton River had a full tree canopy
classified as 90 to 100 percent coverage
over the stream for its entire length,
while the Rapidan and North Fork
Moormans Rivers had about 65 to 95
percent canopy coverage over the
water. The floods destroyed all vegetation along the three rivers and left a
corridor 75 to 100 meters (246 to 328

This photograph is from point 2P009. It was taken on the Staunton River in May 1996 and
shows a pile of woody debris from the trees that were uprooted. It is approximately 90
meters long and 20 meters tall. Prior to the flood, there was 90-100 percent tree canopy
over the river at this point.

feet) wide through the forest. These
storm events also obliterated roads and
trails as well as cultural resources in
and around Shenandoah National
Park. Of the three, the Staunton and
Rapidan drainages were characterized
by the formation of debris flows and
deep channels cut to bedrock in the
tributaries, while the North Fork
Moormans watershed was characterized
by large slippages of soil from the hills
surrounding the stream and some
debris flows.
In the spring of 1996, a project
was initiated to photo document the
vegetative re-growth along the drainages. Points were selected in each of the
watersheds where pictures could be

taken looking in more than one
direction. To ensure that future pictures were looking at the same scene,
compass bearings were recorded, and

The vegetative changes in the last
nine years have been almost as
dramatic as the flood event itself.

each photograph has since been aimed
toward the same bearing. There are 13
permanent points in the North Fork
Moormans drainage, 11 points in the
Staunton River drainage, and four
points in the Rapidan River drainage.
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In the three drainages, a total of 91
photographs were taken twice a year.
The first set of photos, taken in the
early spring, shows the amount of
vegetation left at the end of winter and
its ability to hold soil. The second set
of photos, taken near the end of
summer, shows the amount of vegetation that has grown and provides
canopy cover. Some of the photos also
document how the stream channels are
changing over time. All of the points
have been located and mapped using
Global Positioning Systems.
The first pictures were taken in
April of 1996. These show very little
over-wintering vegetation and are a
close representation of the areas
directly after the flood. Two major
exotic trees, tree of heaven (Ailanthus
altissima), and princess tree (Paulownia
tomentosa), are colonizing most of the
areas. Common mullein (Verbascum
thapsus), another exotic, which had
invaded early on is now mostly shaded
out, and seems to exist only on the
margins of streams and trails where it
can receive more sunlight. The tree of
heaven and princess tree are over 30
feet tall in most places and have
reached 40 feet in others. The only
native plant keeping up with the tree of
heaven and princess tree is black locust
(Robinia pseudoacacia). In all three
drainages, black locust became established about 1998, black and yellow
birch (Betula lenta and Betula
alleghaniensis) in 1998 and 1999,
Virginia pine (Pinus Virginiana) and
tulip tree (Liriodendron tulipifera) in
1999, and red oak (Quercus rubra), in
some places, in 2000. Sycamores
(Platanus occidentalis) started sprouting from stumps and roots on the
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pictures of 3P006 (North Fork of the
Moormans River). Photography was
not started at this location until 1997,
but it is an excellent site for documenting stream and vegetative changes.
Included are the spring 1997 (Figure
1), fall 2004 (Figure 2), and a third
view of the site in late May of 2004
(Figure 3) showing some of the

Figure 1. 3P006, North Fork Moormans
River April 1997. Prior to the flood this
section of stream had approximately 80
percent tree canopy cover.

stream edges in 1996 but were easily
washed/broken off in successive floods.
Sycamores are 15-20 feet tall in the
North Fork Moormans but do not
seem to be as prevalent in the Staunton
drainage.
The dominance of exotics can
be seen in areas like the princess tree
grove on the right hand side of the

Figure 2. 3P006, North Fork Moormans
River September 2004. Most of the trees on
the right hand side of this picture are
princess tree and tree of heaven with some
birch, black locust, and sycamore.

Figure 3. A view from 3P006 taken in late
May 2004 looking slightly to the right of
the normal bearing to show the end of the
princess tree bloom. Many of the trees had
already lost their blossoms at this point.

princess tree in bloom. It is easier to see
the height of the exotics and the reason
they out compete the native plants
(mostly the short green plants) in
Figure 3.
The vegetative changes in the
last nine years have been almost as
dramatic as the flood event itself. The
plant community will continue to
evolve and mature, but it will take
many more years to get the full tree and
shrub canopy needed to help cool and
feed the stream.
David Demarest is a Biological Science
Technician.

Fisheries Projects Update
By Jim Atkinson
Shenandoah Fisheries
Monitoring Program: During 2004, a
larger suite of streams was sampled
than in previous years to incorporate
additional fieldwork associated with
the U.S. Geological Survey (USGS)
“Mercury Bioaccumulation in Fish”
and the “Brook Trout Genetic Diversity” studies that both provided
additional funding for the 2004 field
program. A total of 69 sites along 37
park streams were sampled during the
2004 field season including all of the
annual and non-annual streams
originally scheduled, all of the nonannual streams originally scheduled for
2005 and seven additional streams that
have not been sampled for over 20
years. This latter
group of streams
includes the East
Fork (Heiskell
Hollow) of
Compton Creek
and Jordan River
in north district;
Devil’s Ditch, the
upper Conway
River, Lee Run
and Elk Run in
the central
district; and
Upper Lewis Run
in south district.
Monitoring
program highlights include:

• The parkwide sample included
32,694 fish of 29 species. The total
included 9,779 brook trout, 65
brown trout (principally from the
Rose and Hughes Rivers) and 21
rainbow trout (principally from
the Moorman’s River, North Fork).

• Parkwide brook trout populations
experienced a dramatic rebound
from the population lows recorded
during 2003. This seems to be
largely due to a highly successful
spawn during the past fall and

winter and near optimal water
levels during the period.

• The only noteworthy exception to
the positive brook trout trend was
the documented collapse of the
trout population in Lower Lewis
Run in South District. During the
survey of the entire park section of
the stream, only two adult female
brook trout were encountered.
This small stream had a fairly
robust trout population as recently
as 1997. A research project targeting small, naturally acidic streams
containing at-risk fish populations
is proposed to better understand
the cause(s) of the collapse of this

population and anticipate future
problems.

• Rainbow trout reproduction was
documented in the lower
Moorman’s River for the first time
since Robert Lennon’s (U.S. Fish
and Wildlife Service) 1957 observation of reproducing rainbow trout
in the stream. Eighteen juvenile
and one large adult rainbow trout
were captured within the lower
most of three monitoring sites on
the Moorman’s. A single adult was

captured within the middle site
which is in the vicinity of the Big
Branch tributary.

• A single adult rainbow trout was
recorded within the lower most
monitoring site in Whiteoak
Canyon Run and a single adult
brown trout was recorded within
Happy Creek, approximately 1.0
mile upstream of Front Royal,
Virginia.

• Several yellow bullheads (a new
species for the park) were recorded
from established monitoring sites
in Happy Creek (north district)
and Hawksbill Creek (south
district).
Investigation of Mercury
Bioaccumulation in Fish: This
collaborative study with the U.S.
Geological Survey (USGS), Leetown
Science Center and the University of
Virginia was initiated in 2004 as a one
year project to determine the distribution, abundance, and variability of
mercury in fish within Shenandoah
National Park, and to assess the relationship between streamwater chemistry and mercury accumulation in brook
trout. The intent of the study is to
ensure that mercury contamination
poses no threat to humans or fish
populations in the park. Results of the
study will: (1) provide data needed to
evaluate human health risks associated
with the consumption of fish in
Shenandoah National Park (SHEN);
(2) determine the potential for acute or
chronic problems with trout populations associated with mercury accumulation and toxicity; and (3) improve the
understanding of factors governing the
bioavailability of mercury in stream
ecosystems. The study makes use of the
extensive water chemistry database
developed as part of the Shenandoah
Watershed Study (SWAS) to provide
the basis for sample site selection and
the context for interpreting data.
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A total of 512 fish from 17 park
streams were collected for mercury
analysis. These included brook trout
(420), blacknose dace (30), brown trout
(15), white sucker (15), smallmouth
bass (15), American eel (12) and rock
bass(5). The fish were shipped in three
separate batches to the Trace Element
Research Lab at Texas A&M University
for analysis. A summary of results will
be available upon completion of the
final report in 2005.
Investigation of Brook Trout
Genetic Diversity: This ongoing
study, initiated by the USGS Leetown
Science Center in 2001, will provide a
complete genetic profile of nearly
every brook trout population in the
park through the identification and
characterization of microsatellite DNA
(deoxyribonucleic acid) markers.
During 2004, adipose tissues were
collected from 453 brook trout from 10
park streams and submitted for DNA
analysis. This brings the total number
of brook trout sampled from SHEN
streams to 2439. This year, DNA was
extracted and prepared for microsatellite DNA analysis in over 600
previously collected trout.
Microsatellite DNA analysis was
performed on the 2002-2003 samples
from 16 sites (685 brook trout) representing all three of the major drainages
(Potomac, Rappahannock and James)
that occur within the park. Statistical
analyses have shown a high degree of
genetic differentiation in trout among
the three drainages and among tributaries within the drainages. Brook trout
from the six Rappahannock River
drainage samples that have been
analyzed are highly divergent from the
fish sampled from the Shenandoah and
James Rivers. A range-wide comparison
of brook trout indicates that the fish
inhabiting the upper reaches of the
Rappahannock River are genetically
similar to southern Appalachian brook
trout sampled from Great Smoky
Mountains. This result appears consistent with historical stocking records,
yet contradicts the conclusion reached
decades ago that the introductions of
the non-native brook trout were
unsuccessful. This study is funded
through 2006.
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Mid-Atlantic Network Fish Species
Inventory: During 2004, inventory
efforts were completed within
Appomattox Courthouse National
Historical Park (APCO), Booker T.
Washington National Monument
(BOWA), Eisenhower National Historic Site (EISE), Fredericksburg and
Spotsylvania National Military Park
(FRSP), Gettysburg National Military
Park (GETT) and Valley Forge
National Historical Park (VAFO).

EISE, GETT also included personnel
and equipment from the PFBC. A total
of 15 sites along 10 streams were
sampled in all of the parks combined
during 2004. Inventory highlights
include:
· The diversity and high density of
fishes encountered in the limestone
streams within EISE. A total of
16,851 fish representing 31 species
were captured at EISE in less than
two days of electrofishing within
two park streams.
· The documentation of bigeye
jumprock (Scartomyzon
ariommus), a globally rare
Catostomid (sucker family) within
Gills Creek at BOWA.

Electrofishing survey within Gill’s Creek,
BOWA.

Stream sections within APCO and
BOWA were resampled during late
spring to provide some contrast to the
late summer sampling effort within
these parks in 2002. Selected stream
sections within FRSP were resampled
during early spring in an attempt to
detect anadromous shad and again in
late summer to take advantage of a
return to normal flow conditions
following the drought of 2002. Intensive sampling efforts were completed in
stream sections within EISE and GETT
during August and early September.
During early October, a crew from the
Pennsylvania Fish and Boat Commission (PFCB) completed an
electrofishing survey along the section
of the Schuylkill River that flows
through VAFO. In addition to participation from the fisheries biologist and
crew from Shenandoah National Park,
sampling efforts within APCO and
BOWA included equipment and
personnel from the Virginia Department of Game and Inland Fisheries
(VDGIF). Sampling efforts within

· Nearly one third of the fish
community diversity within Gills
Creek is comprised of
Catostomids. A total of 10 species
have been detected within the
section that flows through or
adjacent to BOWA including
quillback (Carpiodes cyprinus),
northern hogsucker (Hypentelium
nigricans), Roanoke hogsucker
(Hypentelium roanokense), black
jumprock (Scartomyzon cervinus),
bigeye jumprock, golden redhorse
(Moxostoma erythrurum),
shorthead redhorse (Moxostoma
macrolepidotum), silver redhorse
(Moxostoma anisurum), V-lip
redhorse (Moxostoma

Multi-agency crew electrofishing the upper
Appomattox River within APCO.

pappillosum), and white sucker
(Catostomus commersonii).

• A population of mottled sculpin
(Cottus bairdi) encountered in the
central Piedmont (Wilderness Run,
FRSP). These fish are more typical
of coldwater streams in the Blue
Ridge and Valley and Ridge
physiographic provinces. Within
Virginia, disjunct to distant
mottled scuplin population
isolates only occur within the
Rappahannock and James Drainages.

sites and the addition of fyke nets
during 2004 produced the largest fish
sample sizes from the combination of
sampling techniques employed. From
late August through late September,
three additional visits were made to the
park involving one to three of the
Shenandoah fisheries staff during
which intensive angling surveys were
focused along the stream channel at the
confluence of Pope’s Creek and the
Potomac River. Inventory highlights
include:

• Angling was most effective at the
mouth of Pope’s Creek within two
hours before high tide and within
the first half hour following.
Otherwise, tidal currents were too
severe and fish foraging levels
appeared to decline.

• A population of silverjaw minnows
(Ericymba buccata) encountered
in the upper Coastal Plain (Hazel
Run, FRSP). This is the only
known record of the species within
the Rappahannock Drainage from
the upper Coastal Plain. These fish
more typically occur in the central
to upper Piedmont regions of the
drainage.
Northeast Coastal and Barrier
Network Fish Species
Inventory: During 2004, continued
inventory efforts at George Washington Birthplace National Monument
(GEWA) were completed following a
total of five visits to the park. The
primary effort was associated with two,
three-day visits, one during late May
and one in late August. In addition to
participation from the fisheries biologist and crew from Shenandoah
National Park, a significant component
of the inventory during these visits was
accomplished through the assistance of
equipment and personnel from the U.S.
Fish and Wildlife Service per an
interagency agreement. A number of
additional sites were added within
Pope’s Creek from the original 2003

Seining fish near the entrance to Pope’s
Creek, GEWA.

A fyke net set within Pope’s Creek, GEWA.

Jim Atkinson is a Wildlife & Fisheries
Biologist.

• A total of 34 fish species have been
detected within GEWA from all
survey efforts over the past two
years. The expansive Pope’s Creek
system is dominated by white
perch (Morone americana).

• Of the various sampling techniques
employed within the Pope’s Creek
system including electrofishing,
trawling, seining, minnow traps,
eel pots, fyke nets and angling, fyke
nets proved to be the most efficient
technique followed by seine hauls
and angling.
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Improving Distribution of Natural Resource
Information
By Gordon Olson
The year 2004 marked an
important turning point related to the
presence of the park’s natural resource
operation on the World Wide Web.
Development of web material contributes to two key values
that heavily influence
the success of many
programs. First,
preparation and
availability of natural
resource information
helps to educate the
public and share ideas
and data with other
professionals engaged
Natural
in similar work.

Second, writing web material forces
park staff members to synthesize and
summarize their data.
Extensive web material was
written for the Nature and Science

Resources

Profile that appears on the standard
National Park Service template for the
park. Pilot material and web page
design was done for inventory and
monitoring programs. This material
was posted on the
Park’s In Depth
website. In addition, a
page describing the
backgrounds and
roles of natural
resource personnel
and how to contact
them was added to
the In Depth site.
Gordon Olson is a
Supervisory Biologist.

Monitoring Program Reformulated
By Gordon Olson
Shrinking budgets of recent
years are forcing reconsideration of
fundamental approaches to the design
of the park’s monitoring program. After
considerable thought and discussion
on the part of park staff members, a
recommendation to reduce the intensity of sampling for major program
components emerged. The most
significant changes will be in the
aquatic biota and vegetation programs.
Rare plants and vegetation monitoring
will now be monitored every other
year. Fish and aquatic invertebrates will
also be monitored every other year on
the years the vegetation programs are
not being implemented. This rotation
will be implemented beginning in
2005. Other changes that are occurring
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include the suspension of the Monitoring Avian Productivity and Survivorship (MAPS) program (actually
suspended in 2004) and reductions in
funding available to support the
Shenandoah Watershed Study (SWAS).
Concurrently virtually all travel funds
have been eliminated from the monitoring program and funding for
general supplies is greatly reduced.
Unfortunately all of this means that
quantity of resource information and
its frequency of collection are being
reduced. This will eventually have
implications in terms of management of
park resources.
Along with these cost saving
measures, the Natural Resource Branch
has been seeking to establish two

permanent technician positions that
would be focused on botanical and
exotic plant programs. These positions
are considered essential to the stabilization of the monitoring program. The
new positions would join the existing
Biological Technician position to form
an interdisciplinary team to rotate
through fieldwork associated with
forest vegetation, rare plant, fish, and
aquatic invertebrate monitoring.
Gordon Olson is a Supervisory
Biologist.

Mitigation Agreement Finished and
Implementation Begins
By Gordon Olson
After several years of discussion and negotiation, Dominion
Power (formerly VEPCO), the Environmental Protection Agency, the
National Park Service, and the Department of Justice came to agreement on a
Mitigation Plan which outlines actions
to be taken at Shenandoah National
Park in response to a Consent Decree
that mandated restoration efforts that
are needed as a result of damage from
air pollution. Under the Decree, the
National Park Service received $1
million from Dominion Power. Other

actions were also required of Dominion on behalf of a number of other
entities.
The Mitigation Plan outlines
how the $1 million would be spent at
Shenandoah. The three main thrusts of
the Plan are fleet conversion (use of
hybrid technology and replacement of
older diesel technology) improved use
of biodiesel fuel, and public education
related to mobile emissions sources.
Dominion Power wanted the focus of
the Plan to be on mobile emission
sources (automobiles, trucks, trains,

airplanes). During 2004, the park
purchased two of what could be up to
10 hybrid vehicles and put them in
service and an order for a new diesel
trash compactor has been placed. Plan
implementation will continue over the
next four years with more vehicle
replacements, retrofits, and public
education media development.
Gordon Olson is a Supervisory
Biologist.

Shenandoah National Park
National Park Service

LOW EMISSIONS VEHICLE
Clean Air Restoration Effort

Winds of Change for Air Resources Operations
By Gordon Olson
In November of 2003, the
park’s Air Resources Specialist (Christi
Gordon) transferred to another
position with the U.S. Forest Service in
New Mexico. The hope had been to
refill her position but shrinking
budgets forced reassessment of that
decision. In April of 2004, it was
decided that Gordon Olson, the
Natural Resource Branch Chief, would
assume collateral duties as the park’s
Air Resources Specialist. Since that time
he has gradually picked up projects and
responsibilities that Christi had.

Unfortunately his multiple responsibilities have limited his ability to
assume all of the functions that Christi
has had.
Also, during 2004, a new Air
Quality Monitoring Technician
position was created. Liz Garcia has
filled this position (see related article).
She now has full responsibility for
management and operation of the
monitoring station at Big Meadows.
The position is funded by the National
Park Service Air Resources Division in
Denver, Colorado. Now that Liz is on

board, it has allowed us to relieve
Shane Spitzer, Physical Scientist, of
duties related to air quality monitoring. Shane will now focus his time on
park programs related to water, geologic, soil, and meteorological
resources. These moves bring Shane’s
position in line with position management guidelines, allow a professional
scientific position to focus on program
management, and provide renewed
energy to Shane.
Gordon Olson is a Supervisory
Biologist.
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The Mid-Atlantic Exotic Plant Management
Cooperative: Controlling Exotic Plants Amid
Budget Shortfalls
By James Âkerson
Abstract
The Mid-Atlantic Exotic Plant
Management Cooperative is made up
of 12 national parks in Virginia,
Maryland, and Pennsylvania.
Throughout the Cooperative, park
budgets have dwindled, reducing the
time and resources dedicated to
managing exotic plants. The traveling
team has become a stop-gap for minimal monitoring and control work. The
Cooperative remains active by using
innovative methods of getting things
done. Hallmarks include inter-park
cooperation and collaboration with
volunteer organizations, outside
agencies and neighbors.
Highlights for Fiscal Year 2004
• The Cooperative controlled over
25 invasive species in 12 national
parks totaling 388 acres.
• The traveling team collaborated
with Shenandoah National Park
and a park neighbor to control
bamboo along a mutual boundary.
The collaboration better assured
treatment longevity and effectiveness to make sure the exotic did not
quickly recolonize from off-park.
• The Cooperative expanded its
functional capacity by utilizing
Student Conservation Association
interns and park volunteers, and by
initiating a private sector contract.
The expanded results had excellent
success.
• The Cooperative added one new
park by using funds that park
provided for exotic plant control.

• Shenandoah National Park hosted

•

•

a Congressional field tour on the
subject of forest health issues in
cooperation with the U.S. Department of Agriculture-Forest Service.
The Cooperative increased public
awareness of invasive species issues
by participating in five newspaper
and magazine articles, publishing
eight articles in professional
journals and newsletters, creating
three articles posted to National
Park Service websites, and speaking
at four public or professional
meetings. School ecology and
biology classes were targeted to
increase awareness.
The Mid-Atlantic Cooperative is
assisting the Commonwealth of
Virginia by having the Team
Liaison sit on the state’s Invasive
Species Advisory Committee. The
committee’s commission is to
devise a statewide invasive species
watch list and draft a statewide
strategic invasive species plan.

Background
The Cooperative is within a
diverse and highly productive region
spanning the coastal plains of Chesapeake Bay, the vigorous Piedmont, and
the hills and valleys of the Blue Ridge
Mountains. Biological diversity of the
region is one of the greatest in North
America. On the other hand, exotic
plants threaten to destroy native
diversity and ecosystem health by
displacing natives and changing the
complex web of interactions with
simplified monocultures. Protecting

Partner parks and states: Appomattox Court House NHP, VA; Booker T. Washington NM,
VA; Colonial NHP, VA; Eisenhower NHS, PA; Fredericksburg and Spotsylvania County
Battlefields Memorial NMP, VA; George Washington Birthplace NM, VA; Gettysburg NM
Park, PA; Hampton NHS, MD; Petersburg NB, VA; Richmond NBP, VA; Shenandoah NP,
VA; Thomas Stone NHS, MD.
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2004 Accomplishments - All Parks

Inventoried Acres
Gross Infested
Infested Acres
Treated Acres
Monitored Acres
Retreated Acres
Restored Acres
Controlled Acres

3,480
3,053
483
388
123
10
0
0

Park employee and Russian Intern apply
herbicide to Japanese honeysuckle at
Booker T. Washington National Monument
near an historic tobacco barn.

the natural legacy of the region is
essential to assure that future generations enjoy its expanse and beauty.
The Cooperative uses an
integrated pest management approach
where prevention and early detection
are emphasized. Control methods
include hand pulling, manual and
power assisted cutting, prescribed fire,
and herbicide application. Park staffs
work closely with facility
concessioners, construction contractors and farmer permittees to avoid new
exotic plant introductions.
James Åkerson is a Supervisory
Ecologist & Team Liaison. Norman
Forder, Dale Meyerhoeffer, and M. Kate
Jensen are Biological Science
Technicians.

Abandoned Developments Exotic Plant Survey:
2004 Preliminary Results
By James Åkerson
Abstract
Last year the results of
Shenandoah National Park’s 2003
exotic plant survey that focused on its
350-plus miles of park boundary were
reported. In this issue, findings are
presented of the 2004 survey associated
with the grounds adjacent to farmsteads, dwellings, and other structures
that have been abandoned. The survey
statistically sampled 10% of the 700
sites documented in the park’s geographical information system.
Results of the field work
indicate that the most common exotic
tree is tree of heaven (Ailanthus
altissima), accounting for one-third of
all nonnative trees found. Young
ailanthus was also the most common
plant in the shrub layer. The next most
common shrub was Oriental bittersweet
vine (Celastrus orbiculatus). Most
common herb was garlic mustard
(Alliaria petiolata). It was followed by
Oriental lady’s thumb (Polygonum
caespitosum), and Japanese stiltgrass
(Microstegium vimineum).
Geographically, the north
district is the most heavily infested area
in the park. It has 75% of the tree of
heaven and garlic mustard found in the
survey. Oriental bittersweet vine is also
more common in the north district.
Central and south districts have
heavier infestations on the east side.
However, the north district is greatly
more infested on its west side. Importantly, the field data bear out the
hypothesis that exotic plants are
concentrated near abandoned development and diminish with distance from
them, indicating that abandoned
developments act as infestation centers
in the park’s backcountry and wilderness areas.
Introduction
Beginning in 1997, the park
staff conducted a series of exotic
1

(nonnative) plant surveys in an effort
to discover the locations and dominance levels of exotic plants in
Shenandoah National Park. Surveys
focused on developments along
Skyline Drive (1997-1998), current fire
roads (1998-2000), and along the park
boundary (2003). The purpose of the
2004 survey was to gather information
about exotic plants at abandoned
developments such as old farmsteads,
home sites, and other structures in the
park.
When Shenandoah National
Park was dedicated in July 1936, much
of the area was open farm land. Henry
Heatwole (1999) estimates that there

blight wiped them out in the early
1930s. By 1935, Sheaffer (1999) believes
465 families lived in the area that
became the park the following year.
The structures they left behind ranged
from tiny cabins to large farms complete with house, barns and other
outbuildings, as well as churches,
mercantile and the other buildings
associated with farms, homes and
communities. In this report, we refer to
such sites collectively as abandoned
developments.
Abandoned developments are
of interest concerning exotics for two
reasons. First, people often plant
exotics as ornamentals or as shade trees
on home sites. Second, invasive exotics
(those known to aggressively take the
place of natives) often colonize disturbed areas. Human habitation and
farming disturbs the landscape, creating ideal sites for invasives to get a
foothold. This makes developments a
potential source for exotic plant
presence and subsequent expansion by
highly invasive species. The 2004
survey tested such a hypothesis by
determining: (1) the exotic plants and
their relative dominance near abandoned developments, (2) the distance
of exotic plant spread or penetration
into the surrounding environment,
and (3) whether the number and
dominance of exotics diminished with
distance from abandoned developments.

Intact chimney at 2EX441.

Methods
Seventy survey sites became the
desired target to achieve a 10% sample
of the 700 documented sites in the
Park1. Several different proposed sets of
70 survey sites were created using a
random number generator. The
mapped sets were compared to choose
one where the survey sites were not
predominantly clumped together
leaving other park areas unsampled.

had been 10,000 people living in the
area in 1900. Changing economies
(and environments!) greatly reduced
the human population in the Blue
Ridge Mountains during that century.
Many left the mountains due to loss of
the once plentiful American chestnut
(Castanea dentata) when chestnut

It became apparent in the course of the survey that at least one historic site was actually outside the park boundary.
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Global Positioning System (GPS)
coordinates of the chosen site plan
were loaded into a GPS unit to aid the
field crew (Donald Roop and
Stephanie Siersma) to find each site.
Once on location, the field
crew attempted to find the center of the
original home site. Chimneys, fireplaces, foundations or concentrations
of artifacts were used as reference
points. Trees such as apples, pears and
walnuts, and ornaments like mock
orange and daffodils were also used to
find the old development center. (Only
one complete standing structure was
found during the survey.) The team
established an origin near the reference
for the start of a set of plots called a
transect. New GPS coordinates were
taken at the origin and recorded on the
site record sheet to correct the initial
ones provided.
Exotic plants were inventoried
using a series of plots along two
transects at each site location. The
azimuth direction of the first transect
was selected from a random number
table (1-360 degrees). The second
transect headed away from the same
origin at the opposite direction (180
degrees) from the first transect. The first
plot of each transect was located near
the origin, usually at six meters. The
prior surveys, mentioned above, placed
the first plot at the interface of the
disrupted zone and natural surroundings. But, after more than 60 years of
abandonment and regrowth, the
interface of the abandoned developments had become indistinguishable.

Siersma looks for exotics in the 1 by 1
meter subplot.
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Subsequent plots were at 50 meter
south district had 15 sites. The survey
intervals for a total of seven plots along used Skyline Drive as the dividing line
the 300-meter transect or until no
between east and west as a matter of
exotics were found in a plot.
convenience. The Drive generally
The circular plots were 1/100follows the ridge tops separating east
hectare, using a 5.64-meter radius.
and west slopes. There were 49 sites
Exotic species were identified and
(71%) on the east side of the Drive and
divided into three categories where
20 (29%) on the west. Seventeen sites
forbs were less than one meter tall,
were in designated Wilderness (25%).
shrubs were one to
five meters, and trees
Table 1: Breakdown by location of abandoned development
were more than five
meters. Vines growing survey sites at Shenandoah National Park, 2004.
Park District
West
East Totals (Wilderness)
into trees were
(4 – all east)
18
North
5
13
counted as shrubs.
(10 – all east)
36
Central
7
29
Percent ground cover
(3 – all west)
South
8
7
15
for each nonnative
(17)
Totals
20
49
69
tree, shrub, and forb
species was estimated
as well as the total
cover for each of the three categories.
Trees: The field crew found 132 exotic
Within each plot, a 1 m2 subplot was
trees. Of those, 66% were tree of heaven
established and centered 2.82 meters
(Ailanthus altissima). North district had
due north of plot center. Nonnative
64 tree of heaven, 74% of all surveyed
plants were individually counted and
tree of heaven. Only 11 (13%) were
the percent cover was estimated within
found in the central district and 12
each subplot. Tree species were identi(<14%) in south district. Tree of
fied as belonging to one of three size
heaven was more common on the west
classes based on diameter at breast
side than the east. Tree of heaven was
height (DBH) where class 1 trees were
found in 35% of the western plots and
less than 7.5 cm DBH, class 2 trees were
only 12% of eastern plots. The next
most common exotic trees were apples
between 7.5 cm and 15.0 cm DBH, and
class 3 trees were greater than 15.0 cm
and pears (15% of total), found most
DBH. Nonnative tree canopy cover was often in the central district. While
visually estimated and the total canopy
apples and pears are not native, they
cover was calculated using a spherical
are not invasive. Only 4% of total
densiometer. Slope position, forest
exotic trees found during the survey
cover type, ground aspect, and slope
were princess tree (Paulownia
steepness in percentage were also
tomentosa).
determined at each plot.
Notes were taken between the
Shrubs: The shrub class includes any
plots to document anecdotally any
exotic plant between one and five
changes or occurrences of disturbance
meters tall. This class took in a wide
or exotic plant presence.
range of plants. There were ordinary
shrubby plants such as Japanese
Results
barberry (Berberis thunbergii) and
Over the course of the summer, multiflora rose (Rosa multiflora). Tall
the survey team visited 69 abandoned
samples of wineberry (Rubus
development sites and surveyed 129
phoenicolasius) also fell into the shrub
transects with 448 plots. Additionally,
class. Young tree of heaven trees were
two sites at Skyland and one site at
classed as shrubs. Also in the shrub
class were high growing vines includRapidan Camp were not surveyed
ing honeysuckle (Lonicera japonica)
because the data from sites in current,
and bittersweet (Celastrus orbiculatus).
active use would be inconsistent with
Overall, the most numerous
the other sites. More than half of the
shrubs were young tree of heaven.
sites were in the central district (36
They turned up in 46 plots (10%). The
sites). North district had 18 sites and

Table 2: Exotic species found in the tree, shrub and forb layers of the
abandoned development survey plots at Shenandoah National Park, 2004.
TREE LAYER
Ailanthus altissima
Pyrus malus
Pyrus communis
Paulownia tomentosa
Prunus avium
Acer platanoides

SHRUB LAYER
Ailanthus altissima
Celastrus orbiculatus
Rosa multiflora
Rubus phoenicolasius
Lonicera japonica
Berberis thunbergii

FORBS LAYER
Alliaria petiolata
Polygonum caespitosum
Microstegium vimineum
Lonicera japonica
Ailanthus altissima

Also found in tree layer
Celastrus orbiculatus
Lonicera japonica
Syringa vulgaris

Also found in shrub layer
Philadelphus coronarius
Ligustrum sinense
Syringa vulgaris
Acer platanoides

Also found in forbs layer
Polygonum persicaria
Commelina communis
Perilla frutescens
Narcissus pseudonarcissus
Convallaria majalis
Hemerocallis fulva
Coronilla varia
Vinca minor
Achillea millefolium
Iris X germanica
Hesperis matronalis

Wilderness: There were 17 abandoned developments in
Wilderness areas, amounting to 25% of the survey sites. Of
these, four were in the north district, ten in central and three
in the south district. The north district sites had 15 tree of
heaven in 33 plots for an average of 45% of plots. This is close
to the average for the rest of the north district. Central district
had two three of heaven in 36 plots. There were no exotics in
the three south district sites. By chance, the south district sites
were all in very dry areas. Garlic mustard was found in 66% of
the north district plots and 47% of the central district plots.
This is about 10% lower than those districts as a whole.
Oriental bittersweet was found in only four plots, two in the
north and two in the central districts.
Geography: Exotic plants were more likely on the east side
than the west side except for the north district which had the
most on the west side (see Chart 1). North district was the
most infested of the three districts (see Chart 1 and others).
Finally, infestation levels diminished with distance from the
centers of abandoned developments (see Table 3).
Discussion and Conclusions
The survey field crew made several observations while
in the field. The common forbs, Japanese stiltgrass and

Ailanthus altissima Distribution
Shenanadoah National Park
West

Percent

Forbs: The most common exotic herb was
garlic mustard (Alliaria petiolata). It
appeared in 75% of the north district plots
and 59 and 62 percent of central and south
district plots, respectively. The west side
had more exotic forb layer plants than the
east. Garlic mustard was found in 59% of
the western plots and 26% of the east. Next
most common forb was Oriental lady’s
thumb (Polygonum caespitosum), which was found in onethird of the plots. Stiltgrass (Microstegium vimineum) was
found in one-third of the north district plots. It was much less
common in the central and south districts, occupying only
3% and 7%, respectively.
A common thought regarding exotic plants is they
invade and colonize disturbed sites only. The field data
indicate this is not true for garlic mustard, Oriental lady’s
thumb, and Japanese stiltgrass. These shade tolerant plants
flourish under undisrupted forest canopy as long as soil
conditions are suitable for them. They are not found on drier
soils, however.

East
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Chart 1: Percent of tree of heaven (Ailanthus altissima) by
district found in the abandoned development survey of
Shenandoah National Park, 2004.

Exotic Plant Distribution in the Tree Layer
Shenanadoah National Park
Altanthus

Percent

greatest number was in the north district,
but they were also quite common in the
other two districts. In the north district the
most common shrub was Oriental bittersweet vine. It was found in 30 plots (18%).
It was found in nine plots in the central
district and only one plot in the south
district. Multiflora rose was unusual
because it was more common in the south
district than in the other two districts.
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Chart 2: Percent of exotic trees by district found in the
abandoned development survey of Shenandoah National
Park, 2004.
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Chart 3: Percent of exotic shrubs by district found in the
abandoned development survey of Shenandoah National
Park, 2004.
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Chart 4: Percent of plots with exotic forbs by district found in
the abandoned development survey of Shenandoah National
Park, 2004.
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Infested Plots

Radiation of Exotic Plant Infestation
Shenandoah National Park

010

Oriental lady’s thumb were most often found in damp areas.
Garlic mustard could be found in slightly dryer areas. Exotics
were rarely found in very dry forest sites with a healthy native
understory.
The field crew noted that abandoned developments
varied greatly in size and impact on the surroundings. Some
were apparently large, well run farms. Long, well made walls
still attest to the size of the farm and its labor force. Many
home sites were small cabins. Lee Sheaffer (1999), in Appalachian Trail Guide to Shenandoah National Park, writes that
one-half the families living in the area in 1935 were tenet
farmers, living in small, simple homes. Several of the surveyed
abandoned developments were structures other than home
sites. Site 1EX414 was part of the old Panorama hotel. Sites
3EX508 and 3EX509 were part of the Blackrock resort. And
sites 2EX461 and 2EX463 were part of the U.S. Marine Corps
camp that supported Rapidan Camp. It would have been
interesting to have pre-classified the abandoned developments and compared them.
The survey protocol states that when a plot has no
exotics, no further plots are necessary on that transect. The
data show the number of infested plots drops at a steady rate,
indicating the number of exotics decreased with distance.
This supports the theory that exotic plants would be concentrated at the development center and diminish with distance
away. Chart 5 illustrates this very well. Garlic mustard,
Japanese stiltgrass, Oriental bittersweet, tree of heaven and
wineberry all decrease with distance from the origin of the
transects.
Of all the abandoned developments, large farms
appear to be the most likely to harbor exotic plants and to
have high concentrations of them. A supplemental survey of
large farms may be a way to focus in on the highest likelihood
for deep forest infestation and to plan exotic plant control
treatments to reduce forest impacts.
North district has the greatest infestation of interior
dwelling exotic plants. This is also borne out in last year’s
park boundary survey results. Of trees, tree of heaven appears
to be the greatest threat. It also produces a great number of
seeds, is fast growing, and releases chemicals that inhibit the
germination of other plant species. The Pyrus group of
apples and pears is not spreading and does not threaten
native species. In time, natural forest growth will crowd them
out. Princess tree (Paulownia tomentosa) should be watched,
but in this survey, was not numerous enough to merit specific
action.

Plots with R.
phoenicolasius

Distance from Transect Origin

Chart 5: Radiation of infested plots for several exotic plant
species in the abandoned development survey of
Shenandoah National Park, 2004.

Table 3. Number of exotics detected in the abandoned development survey radiating from
transect origins at Shenanodah National Park, 2004.

Distance from Origin --->
Number of plots with exotics
Plots with Alliaria
Plots with Microstegium
Plots with Celastrus
Plots with Ailanthus
Plots with R. phoenicolasius

0-10
meters
124
70
21
12
8
6

50 m
79
56
9
9
3
5

100 m
71
39
10
7
3
3

150 m
56
33
8
4
3
3

200 m
41
26
10
4
3
1

250 m
32
16
5
2
1
1

300 m
23
14
3
1
2
0

Big Meadows Management and Monitoring
Continue with Assistance from the Fire Program
and Maintenance Division
By Wendy Cass
Vegetation management at Big
Meadows continued in 2004 with the
implementation of mowing and
burning treatments. For the purposes of
management, the Meadow has been
divided into three approximately equal
sections termed the east, central, and
west management zones. In 2004,
Meadow management included winter
mowing of the east zone by
Shenandoah Maintenance Division,
and a spring burn of the central and
west zones by the Shenandoah Fire
Management Office. In 2005, manage-

Biotechs sample herbaceous vegetation
along a transect in Big Meadows.

ment will include dormant season
mowing of the central zone, and an
early spring burn of the west zones.
Data on the composition and
cover of woody and herbaceous
vegetation within the Meadow were
collected in August 2004 by members
of the botany and fire effects monitoring crews. The data from this project
have been entered into a database, but
have not yet been examined for trends.
Wendy Cass is a Botanist.

Progress Made Implementing Revisions to Forest
Monitoring Program
By Wendy Cass
The summer of 2004 marked
the second season for implementing a
revised plot installation and vegetation
sampling protocol for the park’s longterm forest vegetation monitoring
program. At this time, 57 plots or 35%
of sites to be included in the final
program have been installed and
sampled. Work also continued on the
programs written protocol. The
document remains in draft form
because of additional work to be done
on the figures and appendices. However, the methods for plot installation
and sampling amidst a myriad of
unpredictable field situations, have
stabilized and been documented.
2005 is the beginning of a new
program structure for the SHEN
natural resources monitoring program.
In an effort to save money, the program

is moving to a rotation system where
vegetation and animal monitoring
projects will alternate active years. Even
though each program will only be
active in one out of every two years, the

Biotechs identify forest herbs while
sampling the vegetation in a long-term
forest monitoring plot.

vegetation crews will contain a greater
percentage of higher graded employees
and approximately 30% more people.
The larger crew size and higher experience level of the crew, will allow more
work to be done in the active year of
each program than could previously
have been done in a single year.
The vegetation monitoring
program will be active in 2005 and will
concentrate heavily on the installation
and sampling of as many additional
forest vegetation monitoring plots as
possible. We anticipate having two
crews, each composed of three to four
technicians or volunteers, who will
collectively install at least 70 additional
monitoring plots.
Wendy Cass is a Botanist.
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Habitat Modeling Completed for Plants of
Economic Importance
By Wendy Cass
Habitat models provide an
efficient way to predict where plants
are likely to be found without having
to field survey the entire area of interest
looking for the target species. These
models are formed by combining
remote sensing information and
environmental variables such as slope,
aspect, landform, and geology, with
knowledge of where the target species
is known to exist. The model can then
be used to generate a map that displays
the degree of habitat suitability for the
target species within an area.
In 2002 and 2003, the
Shenandoah National Park (SHEN)
vegetation monitoring program
assisted with a project to predict the
distributions of plants of economic
importance
using a
habitat
model and
field data.
The target
species
were
American ginseng (Panax
selected in
quinquefolia)
conjunction with criminal investigators from
the park’s Ranger Activities Division,
and included American ginseng (Panax
quinquefolia), black cohosh
(Cimicifuga racemosa), and bloodroot
(Sanguinaria canadensis).
The work at SHEN was part of
a larger project funded by the Natural
Resources Preservation Program to
model the distributions of the target
species in three National Park Service
(NPS) units (SHEN, Blue Ridge
Parkway and Great Smoky Mountains
National Park). The project used a
predictive habitat model originally
developed by Frank van Manen of the
U.S. Geological Survey Biological
Resources Division (USGS-BRD) for
use in the Smokies. As part of the
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project, the Great Smoky Mountains
National Park habitat model was
adapted by John Young of the USGS BRD and Frank van Manen for use in
the Blue Ridge Parkway and
Shenandoah.
Once adapted to SHEN, the
predictive model was used to generate
maps of the park showing predicted
habitat for the target species. In the
summers of 2002 and 2003, NPS
biological science technicians visited
191 points randomly located within
areas predicted to have a high probability of containing the species of
interest. A map verification plot was
located at each of these field points.
The verification plots had an area of
900m2 and were designed to contain

Black cohosh (Cimicifuga
racemosa)

the same amount of area as is represented by one map pixel – the finest
level of resolution within the map. At
each verification point, technicians
collected data on habitat characteristics
and the presence of target species. Data
from 2002 were used to refine the
habitat model and generate new maps
and verification points for the 2003
field season.

Data analysis summarized in a
final report by the USGS (Young et al.
2003) found that model validation
plots from 2003 contained at least one
of the target species (American ginseng,
black cohosh, bloodroot) 89% of the
time. The model was most accurate in
the prediction of black cohosh and was
able to predict the presence of cohosh
80.9% of the time. The model was least
accurate for ginseng, yet was still able
to correctly predict the presence of
ginseng 47.5% of the time. In addition,
the project revealed that ginseng was
11.2 times more likely to be found
when using the model compared to
searching for ginseng without the
model. Black cohosh and bloodroot
were 6.8 and 3.3 times, respectively,
more likely
to be found
using the
model than
without
(Young et
al. 2003).
The
Bloodroot (Sanguinaria
completed
candadensis)
model was
used to generate a final set of maps that
predict the degree of habitat suitability
for each target species. These maps are
now available to assist with monitoring
and protection efforts by natural
resource and law enforcement personnel working to protect ginseng,
bloodroot, and black cohosh throughout the park.
References
Young, J.A., F.T. van Manen, and C.A.
Thatcher. 2003. Habitat modeling for
protection of illegally harvested
plants in National Parks of the Blue
Ridge Mountains. National Park
Service Report. U.S. Geological
Survey.

Wendy Cass is a Botanist.

Cliff Management Project to Start in 2005
By Wendy Cass
Rock outcrops and cliffs are
some of the most visited areas in
Shenandoah National Park (SHEN),
and are sought out by picnickers,
hikers, climbers, and other
recreationists alike for their spectacular
views and recreational opportunities.
Because of their location and environmental characteristics, outcrop and cliff
areas support unusual and delicate
plant and animal communities. These
communities typically occur on thin
soil, or in lichen dominated environments and are extremely sensitive to
trampling and other human activities.
The Virginia Department of Conservation and Recreation (VA DCR) began
expressing its concern to SHEN about
the degradation of high elevation areas
in 1993 with a preliminary assessment
of rare plant communities and their
associated plant and animal species. In
response to these concerns, and
continued evidence of progressive

National Park Service
U.S. Department of the Interior

degradation of cliff and outcrop areas,
park staff worked together to apply for
funding to address the problem.
The grant application was
successful and fiscal year 2005 marks
the start of the long-awaited Cliff
Management project. The project is
funded by the Natural Resources
Preservation Program (NRPP) and will

run from 2005 through 2007 at a cost
of $521K. Project coordinators, Wendy
Cass and Steve Bair, will be working
closely with cooperators from the
Virginia Department of Conservation
and Recreation, Virginia Tech, and U.S.
Geological Survey Biological
Resources Division for the duration of
the project.
The project will begin by
mapping cliff and outcrop areas
throughout the park. Approximately
50 of these areas will then be selected
for further study, and surveyed for
geological, botanical, and zoological
resources. Social science and visitor
use assessments will be done on a
subset of cliff areas to examine the
intensity, impacts, and distribution of
cliff visitation. Additionally, visitor
education and the production of cliffrelated trailhead displays will be
integrated into the project to increase
awareness of cliff area value and
sensitivity. The project will culminate
in the production of an interdisciplinary cliff management plan to guide
recreational activities and cliff protection measures in the future.
Wendy Cass is a Botanist.

Shenandoah National Park lies astride a
beautiful section of the Blue Ridge, which
forms the eastern rampart of the Appalachian
Mountains between Pennsylvania and Georgia.
In the valley to the west is the Shenandoah
River, from which the park get its name, and
between the north and south forks of the river
is Massanutten, a 40-mile-long mountain. To
the east is the rolling Piedmont country. Providing vistas of the spectacular landscape is
Skyline Drive, a winding road that runs along
the Blue Ridge through the length of the park.
Address
Shenandoah National Park
3655 Highway 211 East
Luray, Virginia 22835

The National Park Service cares for the special
places saved by the American people so that
all may experience our heritage.
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New Vegetation Map to be Completed in 2005
By Wendy Cass
Just about anyone who has
been to Shenandoah National Park
(SHEN) is familiar with the Skyline
Drive, overlooks, and developed areas.
Others have ranged further afield and
enjoyed the many streams, trails,
campsites, shelters, and cultural relicts
found throughout the backcountry. All
of these features are fairly easy to
envision and place on a map, but what
fills the rest of the space between the
park boundaries? Most of it is filled
with plants, or to be more accurate,
plant communities. A plant community
is generally defined as groups of plant
species growing together in a suitable
habitat.

A Virginia Department of Conservation and
Recreation field botanist and NPS technician
travel through a robust population of
interrupted ferns (Osmunda claytoniana)
on their way to a vegetation sampling plot.

Some management benefits to
understanding the composition and
distribution of park plant communities
include: (1) an improved ability to
understand and predict fire behavior,
(2) a greater ability to predict the
susceptibility of the park to non-native
insect pests and environmental pollutants, (3) information about where to
send visitors seeking a particular
experience or resource of interest, and
(4) improved knowledge about
available wildlife food sources and
habitat. At the core of these and other
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benefits is the fact that vegetation
mapping “fills in the gaps on the map”.
In doing this, it helps in understanding
the full scope, components and
characteristics of the natural system
being preserved.
SHEN currently has an 18 year
old vegetation map that divides the
park into eight forest cover types based
on tree canopy composition (Red Oak,
Cove Hardwood, Yellow Poplar, etc.).
Despite the broad mapping categories,
this vegetation map had been extensively used by resource management
staff to plan and complete projects.
Even though vegetation
appears consistent over the short-term,
it is not static. Vegetation communities
can change in response to many things
including succession, disturbances, and
changing environmental conditions.
For this reason, vegetation maps need
to be periodically re-done so that they
accurately reflect the vegetation
composition in the field. The vegetation of SHEN has undergone some
extreme changes in the last 18 years in
response to disturbances such as the
gypsy moth, hemlock woolly adelgid,
and storms. These changes prompted
natural resources staff to seek funding
in 1999 to replace the old vegetation
map.
The park’s new vegetation map
has been in process since 2001, and has
cost $295,000 provided by a grant from
the NPS Natural Resources Preservation Program (NRPP). The new map
was developed largely through the
efforts of John Young of the U.S.
Geological Survey Biological
Resources Division, and Gary Fleming
of the Virginia Department of Conservation and Recreation, Natural Heritage Program. Young led the effort to
compile and analyze remote sensing
data from multi-spectral satellite
imagery and aerial photos, to assess the
distribution of vegetation communities

in SHEN in relation to ecological units
defined by terrain and landscape
structure. Fleming coordinated field
vegetation plot sampling, and vegetation community classification work
using multivariate ordination techniques.
In the end, 34 vegetation
communities were identified and
mapped to a resolution of 15 meters.
These communities have each been
described within the National Vegetation Classification System to the
Association level, and compiled into a
field plant community identification
key. The final vegetation map will be
delivered in early 2005 and will

A vegetation mapping crew records
vegetation composition and cover in a
thickly vegetated sampling plot.

include grid and polygon digital data
showing plant communities throughout the park.
Wendy Cass is a Botanist.

Big Meadows Area Deer Population Trends Over
the Last Five Years
By Rolf Gubler

Results
• Fall nighttime spotlight counts
from 1999-2003 have yielded an
average of 212 deer per square mile
(n=49) in the BMA.
• Spring nighttime spotlight counts
taken from 2000-2004 have yielded
an average of 200 deer per square
mile (n=33).

•

•

Fall nighttime counts from 19992003 have yielded relative deer
densities ranging from 103-451
deer per square mile.
Spring nighttime counts from
2000-2004 have yielded relative
deer densities ranging from 76-331
deer per square mile.

BM Deer Spotlight Counts

year. Fall Meadow usage has fluctuated
from 21 deer/night in 1999, to 10 deer/
night in 2000, to 29 deer/night in fall
2001, to 36 deer/night in 2002, and 13
deer/night in 2003. The apparent drop
in usage of the Meadow may have been
due to the bush-hogging that took
place in October 2000. Bush-hogging
in fall reduces
available food
and cover in the
Meadow for deer.
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Future Research
Spotlight
200
surveys give a
good indication
150
Fall
of relative deer
Spring
density and
100
population
trends in the
50
BMA. For comprehensive
0
population
1999
2000
2001
2002
2003
2004
parameters, a
Year
population
dynamics study is
This graph depicts the average number of deer/night in a
0.70 square mile survey area at BMA.
needed. For this
reason, Natural
and Cultural
Resources staff has been working with
Emerging Trends
Virginia Tech Researcher (Dr. Mike
The graph above shows a 5Vaughn) on a Fee Demonstration
year downward trend in relative deer
proposal for an in-depth deer study in
densities in the BMA. However, given
the Big Meadows Area and the Loft
the cyclical nature of herbivore populations, this may turn out to be a typical Mountain Area. The goal of this
proposed study will be to focus on
down-turn in relative deer density. It
population dynamics and conduct a
will be interesting to see if BMA deer
demographic analysis of deer in these
densities climb back up to 1999-2001
two areas of Shenandoah National
levels in future years.
Park. The study would focus on
Comparing fall spotlight
determining deer densities, mortality
counts to spring counts, habitat usage
rates, survival rates, recruitment rates,
generally drops off in spring in all
dispersal rates, herd health, and
areas except the Meadow. New growth
seasonal movement patterns. This
of grasses and forbs plus less severe
study would be combined with a study
weather in spring (vs. fall), probably
attribute to this difference.
to monitor the effects of sustained deer
The Meadow has seen notable
browsing on Big Meadows vegetation
fluctuations in fall usage from year to
and rare plants (by constructing deer
Average # of individuals
( w/ Std Error )

Since fall 1999, Natural and
Cultural Resources (NCR) staff has
conducted nighttime spotlight counts
of deer in the Big Meadows Area. The
purpose of this survey is to show longterm trends in relative deer densities in
the Big Meadows Area (BMA). Big
Meadows deer densities have likely
exceeded biological carrying capacity
for 20 or more years as evidenced by
visible effects in the landscape. Visible
effects include: defined browse lines,
loss of native herbaceous ground cover,
diminished woody regeneration, loss
of ground-nesting songbird habitat,
and an abundance of non-preferred
plant species dominating the landscape. Lack of hunting and predation
on the deer population plus ongoing
maintenance of grassy openings,
contribute to high relative deer densities in the BMA.
The BMA includes ideal deer
habitat - a combination of meadow,
mature forest, forest edge, old orchard,
dense cover, and permanent water. For
these reasons, the BMA can support
more deer than a contiguous mature
forest setting. However, at densities of
roughly 200 deer per square mile (see
graph) they run a much higher risk of
disease outbreak, parasites, and winter
die-offs (from starvation). Additionally, these deer are having an incredible
amount of sustained grazing and
browsing impact on the BMA (since
each deer consumes 4-6 pounds of
vegetation per 100 pounds of body
weight/day).
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exclosures). Ultimately, this would
help to document the impact on
vegetative communities and determine
biological carrying capacity.
The results of a Population
Dynamics Study are essential if protecting the rare plant communities*, floral
diversity, songbird habitat, woody
regeneration and vulnerable landscape
features in the BMA is wanted. This
information will help in understanding
the dynamics of the Big Meadows deer

herd and help to build a foundation
for developing future management
recommendations and options.
* Big Meadows contains 18% of the
park’s State rare plant species (Report of
the Virginia Department of Conservation
& Recreation, Division of Natural
Heritage).
White-tailed deer in Big Meadows.
Photograph by John Mitchell. NPS Photo.

Rolf Gubler is a Biologist.

Water Resources Scoping Report
By Shane Spitzer
In August 2004, the
final publication of the Water
Resources Scoping Report for
Shenandoah National Park
was completed. The Water
Resources Scoping Report
provides an overview of state
and federal water-related
legislation, summarizes the
ecological setting and hydrologic environment of the park,
identifies significant water
related issues and information
needs, and presents recommendations for management
consideration. The report is a
culmination of almost two
years of effort by the Water
Resources Division and park
staff. Input was solicited from
federal, state, and local
agencies as well as the private
sector. The report concludes
by identifying the following as
high priority water resources
issues needing attention:
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• Inventory and classify wetland
attributes
• Re-evaluate existing waterbased monitoring programs
• Restore streams impacted by
acidic deposition
• Research impacts of changing
chemical composition of streams
on aquatic biota
• Inventory impacts on water
quality
• Research mercury deposition
and impacts
For more information, the report
can be found at: http://
www.nature.nps.gov/water/
Scoping_Reports/
shenandoah%20screen.pdf
Shane Spitzer is a Physical
Scientist.

Physical Sciences Project Updates
By Shane Spitzer
Project Title: Assessment of the
Hydrology of the Sensitive Wetland
System at Big Meadows, Shenandoah
National Park
This project seeks to characterize the hydrology of Big Meadows by
collecting new data on groundwater
flow, analyzing these data, and synthesizing the data through the use of
models. The project is being done
through a cooperative agreement with
the University of Virginia and is
funded through the Natural Resource
Preservation Program.
The shallow aquifer underlying the large meadow adjacent to the
visitor center at Big Meadows is the
focus of this study at least through
FY05. Last summer two shallow
monitoring wells were placed near the
middle of the Meadow approximately
200 meters apart. They both reached
depths of about 2.5 meters, which was a
meter below the water table at the time
of emplacement in June. Pressure
transducers were suspended in both
wells, continually recording water
levels at 15 minute intervals. Two more
wells were established; then the presence of abundant cobbles, which occur
as float in the soil throughout most of
the Meadow, made normal construction of the remainder of the wells
impossible. A permit amendment was
obtained to allow a larger diameter
hole for easier emplacement of well
piping. Because of this, an archeological survey was then required at each
site. Throughout September, Carol
Nash and her team of archeologists
from James Madison University
examined material that was dug from
12 additional sites. Currently 16 well
locations have been completed and are
being monitored.
Plans for this year include
continued monitoring of wells already
installed, a groundwater pump test
using one of the water supply wells,
and preparation of a thesis by Lars
Nelson from the University of Virginia.

Project Title: Integrated Climatic
Database for the Shenandoah
National Park
The purpose of the
Shenandoah Climate Database Development project is to inventory, assess,
and assemble historical climate data
from myriad sources in a useful,
accessible, and clean database, with
subsequent assessments regarding the
suitability of various systems for
creating a continuous, high-quality
data stream into this database. This
database will be operational, with
interactive querying capability. The
project is being done through a
cooperative agreement with the
University of Virginia and is funded by
Regional Science funding.
Pursuant to this purpose, the
project has begun with a broad-based
review of available data sources for the
park, both past and present. No final
determination has been made regarding
the selection of datasets and data
sources to include in the database. This
is partly contingent upon the response
of varying parties, including the
National Weather Service, to queries
regarding the archival of past data.
The development of the
database has begun and population of
the database will continue through the
first quarter of 2005. Final completion
date for the project is July 2005.

Project Title: Identification of Native
Brook Trout Stream That Are
Impaired by Acidification
The purpose of this project
was to obtain 12 monthly field pH
measurements from 20 of Virginia’s
most acidic native brook trout streams.
Six of these streams were located within
the park. Sampling took place from
October 2003 to September 2004. Data
are currently being quality assured and

analyzed. The results of this project
will lead to additional streams being
listed as impaired by the Virginia
Department of Environmental Quality
and will be reported in the next
revision of Virginia’s Clean Water Act
Section 303(d) listing. This project is
being done by the University of
Virginia and is funded by the Virginia
Water Resources Research Center.
Shane Spitzer is a Physical Scientist.
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Hemlock Woolly Adelgid Update
By Mary Willeford Bair
Hemlock woolly adelgid
(Adelges tsugae) continues to threaten
hemlocks in Shenandoah National
Park. First discovered in the park
during the fall of 1988, they are now
wide-spread throughout. Few
hemlocks have escaped colonization by
this serious forest pest. Heavy
infestations of hemlock woolly adelgid
on eastern hemlock trees have
progressively led to crown health
decline and tree mortality which
threatens to eliminate all eastern
hemlock stands in Shenandoah
National Park.

Rapidan Camp in the central district;
and North Moorman’s River in the
south district. Crown health data
collected in recent years was compared
to baseline data collected the first year.
The percentage of dead trees within
monitored stands has significantly
increased.
RESULTS
Comparisons between tree
crown health data from 1990/1991 to
2004 show a dramatic shift of trees
exhibiting excellent crown health
(crowns with 90-100% foliage intact)
to ones exhibiting poor crown health
(1-49% foliage intact) or that are dead.
By 2004, adelgid-attributed mortality
had increased from an initial 8% to
93%. Additionally, moderate-poor
canopies comprised less than 10% and
excellent canopies were nonexistent in
2004 (Figure 1).

DISCUSSION
Although the small sample size
and the site selection technique do not
allow us to draw comprehensive
conclusions about parkwide hemlock
health, data from the sites provide a
snapshot of crown health in dense,
untreated hemlock stands. A revised
sampling scheme was implemented in
1999. This new sampling design allows
conclusions to be drawn about
hemlock crown health on a parkwide
basis but the data has yet to be
analyzed. Despite this lack of analysis,
it is clear that hemlock woolly adelgid
has caused significant decline in
hemlock crown health and tree
mortality has increased parkwide.
Without intervention, there is a
very real possibility that this insect pest
could directly or indirectly eliminate
eastern hemlocks from Shenandoah’s
ecosystem. Efforts to extend the lives of

100
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In 1990, park staff established
six monitoring sites within hemlock
areas in accordance with established
protocols for forest vegetation
monitoring (Smith and Tolbert, 1990)
under the auspices of the park’s Long
Ecological Monitoring Program.
Locations of sites are Thornton River
in the north district; Pass Run,
Whiteoak Canyon, Limberlost,

20 Resource Management Newsletter

70

% Trees

Hemlock woolly adelgid infestation on
hemlock branches.
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Figure 1. Comparison of crown health by year. Crown class is based on the percentage of
foliage intact: Class 1: 90-100%; Class 2: 50-89%; Class 3: 1-49%; and Class 4 & 5: dead.

References

our remaining healthy hemlocks
continue. Adelgid suppression in 2005
will be accomplished through
insecticidal soap spraying and by soil
treatments of MeritR. The systemic
pesticide MeritR (Imidacloprid) remains
at effective levels to adelgids for over a
year. The battle to save a lasting remnant
of Shenandoah’s hemlock gene pool for
future generations continues.

Smith, D.W., and J.L. Tolbert. 1990.
Shenandoah National Park Long-Term
Ecological Monitoring System, Section
II, Forest Component User Manual, 1st
Edition. Virginia Polytechnic Institute
and State University, Blacksburg, VA.
(with revisions by Wendy Cass, 1999).

Mary Willeford Bair is a Biological
Science Technician.
Hemlock mortality viewed from Hemlock
Springs Overlook.

Shenandoah National Park Begins Sudden Oak
Death Surveys
By Mary Willeford Bair
A new exotic pest may be on its
way to Shenandoah. The pathogen
(Phytophthora ramorum) that causes
Sudden Oak Death (SOD) has been
prevalent along the western coast of the
United States for some time.
Unfortunately, contaminated nursery
stock from the west coast was
accidentally shipped to the eastern
states. Many of these plants were

subsequently sold and planted before it
was discovered that they harbored
SOD. Due to the concern for the
possible spread of this disease and
potential impact on eastern forests, the
National Park Service Washington
Office provided a modest amount of
funding to conduct preliminary
detection surveys in Shenandoah
National Park. Samples of plant species

known to be susceptible to SOD were
collected at 15 parkwide sites during
2004. All 133 samples were negative for
the presence of the pathogen
responsible for SOD infections.
Mary Willeford Bair is a Biological
Science Technician.
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PowerPoint: Tips and Tricks for Keeping
Presentations Small
By Alan Williams
More and more people now
use PowerPoint instead of a slide
projector to give presentations.
PowerPoint has allowed presenters to
add many more options, such as text,
custom transitions, and graphical
animations to their ‘slide’ programs.
Though the days of a slide being in
backwards or out of focus may have
passed, there are always new challenges
with the new technologies. Common
problems people have with
PowerPoint are large file sizes and
consequently slow loading presentations. This article will point out a few
tips and tricks for slimming down and
speeding up your PowerPoint.
Typically, users who are
showing multiple digital pictures in
their presentation run into the problem
of the PowerPoint file getting quite
large. Logically as images are added to
the presentation, the PowerPoint file
must grow to store that digital information, but the question is, Why do some
digital pictures seem to add more than
what might be expected? This often has
to do with the resolution of the
original picture and how it was
brought into PowerPoint. So how can
you keep you PowerPoint files from
getting too big?
Getting Pictures In
There are a few different
methods for getting images into your
presentation. In PowerPoint 2002, the
simplest method for getting an image
file uses the Menu items: Insert>
Picture>From File (Figure 1). However
it is also possible to cut and paste
images from other computer programs
into PowerPoint. If you use this
method it is advisable to use the Edit>
Paste Special> “Picture” option
(Figure 2) to minimize links to other
programs that tend to ‘bloat’ the size of
the PowerPoint file.
Picture Resolution
High resolution pictures from
scanners or digital cameras add unnecessary size for the majority of
PowerPoint presentations which are
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Figure 3

Figure 1

asking you how to proceed. If you
want to get the smallest file sizes
possible then choose: Apply to> All
Pictures in Document, Change Resolution> Web/Screen, and Check both of
the Options> Compress pictures &
Delete cropped areas from pictures.

Figure 2
shown using an LCD projector or a
computer screen. This is because most
high quality computer displays are set
at 1000 pixels wide by 750 pixels high
while many scanners or digital cameras
are set to produce images with much
higher resolution (For more information see Reference). The extra pixels are
not shown, therefore are wasted. In
previous versions of PowerPoint, to
keep these wasted pixels from adding
size to your file, you needed to resize
or make low resolution versions of the
large images before bringing them in.
In PowerPoint 2002, there is a new
“Compress Pictures” feature that will
do the resizing for you (before trying
this feature Save your presentation).
To use this feature, select an
image in your PowerPoint presentation and then right-click and go to
“Format Picture”. On the “Picture” tab
press the “Compress” button. You can
also get to this feature by looking for a
new button on the “Picture” tool bar
(Figure 3). If you don’t see the Picture
tool bar go to Menu> View> Toolbars>
Picture. You should then get the
“Compress Picture” screen (Figure 4)

Figure 4
Then do a Menu> File> Save As… to a
new file name. You should then be able
to use the Windows Explorer to
compare the file sizes between the
original and compressed pictures in
PowerPoint. In some cases you may
want to keep the primary version of
your PowerPoint uncompressed in
order to print out high quality handouts, but then make a compressed
version for your presentation or for
sharing with other users. Experiment
with this feature to see how it can best
work for you.
References
1) http://www.powerpoint
backgrounds.com/powerpointgraphics.htm
2) http://www.ipaw.org/pp.htm
3) http://www.bitbetter.com/powertips.htm
4) http://www.microsoft.com/office/previous/
xp/tips/powerpoint.asp

Alan Williams is a Ecologist.

New Permanent Employee -- Liz Garcia
By Liz Garcia
It’s great to finally be a permanent part of Shenandoah National
Park. I started my career with the
National Park Service at Shenandoah as
a Student Conservation Associate in
2000. I had worked with resource
management personnel monitoring
peregrine falcons and updating the
backcountry signs and campsite
inventory. In 2001, I become a seasonal
Biological Science Technician working
with Backcountry and Wilderness. The
next season I worked as a Fire Effects
Monitor and had my first chance to
fight forest fires both in the east and
out west. In 2003 and 2004, I worked
seasonally with resource management
again. In addition to managing the
peregrine falcon hacksite and working
on the Hogcamp Branch Stream

Restoration project, I also picked up
numerous forest health projects. I am
now a part-time Physical Science
Technician.
In 2001, I received my Bachelor of Arts from Green Mountain
College in Poultney Vermont, major-

ing in Environmental Studies with a
minor in Adventure Recreation. I then
went on to receive a Masters of Professional Studies in 2002 from the State
University of New York (SUNY) College of Environmental Studies and
Forestry, located in Syracuse New York.
There I mastered in Natural Resource
and Recreation Management.
I am originally from
Gloversville, New York. It’s a small
town about five miles south of the
Adirondack State Park and an hour
northwest of Albany. I am currently
living in New Market with my husband
Solim, who also works at Shenandoah
National Park, and our beagle Buddy.
Liz Garcia is a Physical Science
Technician.

New Employees to Share Duties in Natural
Resources
By James Åkerson
Two new term Biological
Science Technicians were hired in
February 2005. They are Jacob (Jake)
Hughes and Nicholas (Nick) Fisichelli.
They join David Demarest as a threeperson roving team to conduct
fieldwork in botany, exotic plant
management, fisheries, and wildlife
management.
Jake Hughes holds a Bachelor
of Science in Biology from the
University of Maryland - College Park.
He has recent experience at Rock Creek
Park in Washington, D.C., where he
worked in exotic plant control as a term
and temporary employee for three
years. He led crews involved in exotic
plant management and various other
vegetation tasks. He also worked in
horticulture at the U.S. National
Arboretum in Washington, D.C. Jake
will be the lead technician for the Park’s

New term employees, Nick Fisichelli (left)
and Jacob Hughes (right).

exotic plant management program. He
will also spend significant time with
botany tasks. In his spare time, Mr.
Hughes enjoys botanizing, fishing and
playing the bass.
Nick Fisichelli holds a
Bachelor of Science - Resource
Ecology and Management from the

University of Michigan. He was a
temporary employee with the Natural
Resources Branch at Shenandoah
National Park beginning in 2003.
During his first season, he surveyed the
park boundary for invasive, exotic
plant species. Prior to his arrival at
Shenandoah, Mr. Fisichelli worked at
Lassen Volcanic National Park and
Oregon Caves National Monument in
natural resource management and fire
management. He will be the lead
technician on the park’s botanical
programs. His primary projects include
the installation and sampling of 160
long-term forest monitoring plots and
the monitoring of rare plant
populations and communities.
James Åkerson is a Supervisory
Ecologist.
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The purpose of the Shenandoah National Park
Resource Management Newsletter is to convey
information on Shenandoah’s natural, cultural,
and backcountry/wilderness resources, issues,
and programs to park employees and the interested lay public. We will strive to present a mix
of current activities, research and monitoring
findings, and basic information about the park’s
resources in an informal publication on a annual
basis. We welcome short articles meeting this
purpose from both park staff and cooperators.
Paper copies of the newsletter will be distributed to park employees and others upon request,
and will be distributed with permission by the
Shenandoah National Park Association to its
members.
Editor
Debbie Sanders
Chief of Natural & Cultural Resources
Gary Somers
Comments? Write to:
Superintendent
Shenandoah National Park
3655 Highway 211 East
Luray, VA 22835

National Park Service
U.S. Department of the Interior
Shenandoah National Park
3655 Highway 211 East
Luray, Virginia 22835
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Editor’s Note:
If you wish to be removed from this
mailing list, please call Sharon Henry
at (540) 999-3493.

